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Preface

The purpose of this manual is to provide information about using the Management
Portal in Ensemble. Although this manual has been written to describe tools users can
use to monitor the Ensemble Integration Engine, the beta testing process has
identified that users should not use only these features but should use the full
Management Portal for the Integration Engine.

Note: This manual contains screenshots and instructions specific
to Ensemble version 2012. Sites using Ensemble version
2009 or 2010 should use the Ensemble Management Portal
Manual (ag__0720.01u_ens.pdf) for screenshots and
instructions specific to those Ensemble versions.
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Management Portal Manual

Preface
September 2013

vii



Patient Registration MPI Interface (AG) Version 7.2 Patch 02

1.0

Introduction

For over a decade, hospitals and health centers of the Indian Health Service (IHS) and
numerous tribal health programs have used an information system called the
Resource and Patient Management System (RPMS). RPMS is a highly integrated
system consisting of some 50 health care and administrative applications. Virtually all
of the RPMS applications directly interact with one or more, and sometimes many, of
the other RPMS applications.

RPMS applications are required to interact with the Master Patient Index (MPI) to
meet the needs of the IHS MPI initiative. The RPMS/HL7-Optimized (HLO)
interface is a way to send patient information Admission, Discharge, Transfer (ADT)
to the MPI and to receive treating facility information from the MPI and store it into
the RPMS database.

When the MPI and the RPMS/AG (Patient Registration) MPI Interface are complete,
the MPI will be the primary data repository for enterprise-wide patient data.

This manual describes the tools that are provided to manage and monitor the
Ensemble Integration Engine (EIE). The first part of the manual describes to the end
user how to use the portal in the day-to-day management of the interface. The second
part of the manual describes the portal in more technical detail for Office of
Information Technology (OIT) personnel to assist the end user in configuring the EIE
and in troubleshooting problems.

Note: Detailed instructions for installing and configuring the
AGMPI production in Ensemble are found in the Patient
Registration (AG) MPI Interface/Ensemble Installation
Guide and Release Notes.

Ensemble 2012
Management Portal Manual Introduction
September 2013
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2.0 Productions and Namespaces

A production, the unit of delivery for Ensemble-based development projects, is a
package of host classes and configuration items that solves a specific integration
problem for an enterprise.

The AGMPI interface sends messages between RPMS and the MPI system to
maintain the integrity and accuracy of patient records. The
AGMPI.PatientRegistration production uses the EIE to provide a suite of tools for
managing, monitoring, and troubleshooting the message transport between the two
systems.

Productions can be started and stopped, configured, and monitored from the
Ensemble Management Portal. In addition, errors such as messaging errors and
connection errors trigger e-mail alerts from EIE.

A namespace is a collection of one or more productions. The AGMPIxxx namespace
created during the AGMPI installation process (where “xxx” is the site’s production
namespace) contains only one production (the AGMPI.PatientRegistration
production).

Note: The Ensemble installation procedure creates several
namespaces for internal use by the Ensemble engine:
%SYS, DOCBOOK, USER, SAMPLES, ENSEMBLE,
and ENSDEMO.

All system-provided namespaces except ENSEMBLE and
USER are overwritten upon reinstallation or upgrade. For
this reason, InterSystems recommends creating new
namespaces, rather than placing custom code in any of the
system-provided namespaces, where it could be overwritten
and lost.

Ensemble 2012
Management Portal Manual Productions and Namespaces
September 2013
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3.0

3.1

3.1.1

Management Portal

Ensemble’s Management Portal provides access to the tools and components required
to manage the AGMPI namespace and the AGMPI.PatientRegistration production
instance. The Ensemble portion of the Management Portal contains a subset of the
tools available in Ensemble.

Note: Itis critical to get permission from OIT before running a
production instance. The patient bulk load file must be
activated by OIT before running any Ensemble production
instance.

It is highly recommended that sites use the full Management Portal to properly
monitor the EIE. A training program for the use of the Management Portal is
currently under development. This training program must be coordinated with the
rollout training offered by OIT in support of the entire enterprise deployment of
Ensemble.

Portions of the Ensemble AGMPI documentation will change based on the rollout of
final production.

Navigating in Ensemble
Navigation Links

Pages in the Management Portal have navigation links (often called “breadcrumbs™)
located above the display area (Figure 3-1).

& Prodution Contrguraban - Wondows Internel Explorer

@E}- | & Ftp/10.24 196 4357775 geivpig

% @ Covert v & Select

x Coogle = 9 search - 5 Share | Moem 3@ Sign in
i Favarites | g @] iBankVersiond ] Microsoft Exchange - Oul.. | Delick Time & Expense - . @ Suggested Siies = 8] Wk

& Produstion Configuration i = B = 7 #m = Page~ efely~ Tguk~ i@

“

Harnesace AGMPIGOLDY Switch Ense.mble

ER VD ENMEISDO00 |
i Unknownlbsier Iensd 1 Vanged, nc. Instaric E3MS

Viev.r:D i 02 Retresh: © o0 & off Sort: Hama  Stat
Catagory: Al - Lo
Services * Processes * Operations *
MPlnbound AGMPLMF a !

RPMSInBound AGMPLRPMEMessagaRouting EmailAlen
Ens. Alert MPICuBound

Figure 3-1: Management Portal navigation links
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e Use the navigation menu on the left side of the page to navigate to pages required

to administer the current production instance. See Section 3.1.4 for a description
of each menu item.

After navigating to another page using a menu item, the navigation links shown in
Figure 3-2 provide a reference to the page’s location within the portal.

e To return to a previous page, click the page name in the navigation links.

3.1.1.1 Navigating to Home Page

The Home link (Figure 3-2) navigates to the Management Portal home page.

i Unro sl iser Liernsnd 1o Viangend, nc. Instance E3MS by larsysems
) Retesh: ©on & off Sort: Mame Status  Numbe

Production Configuration

Category Al

Categony - Lugend 0 Sullings
Services * Processes * Operations *
") MPlisboond AGMPL " " ) BadWessag
HPMSInBound AGMPI 0 @E : m v @l s
Ens Alart MEIChitEsund

Figure 3-2: Home link

Note: The Management Portal contains sub-menus, each denoted
by a right-pointing double angle quotation mark
(quillemet). Navigate to the sub-menus by clicking the
appropriate menu link, and then clicking the sub-menu
link(s), as shown in Figure 3-3.

User _SYSTEM e =
View: D ] Sosrchi[ 1 Management Portal
o Home e
L] Build » Production Monitor : ) T
View » Queues _

- -
(, DeepSee List» Jobs View the Ensemble system
- | monitor

Sy stem ime
B4 Th 2
=, Manage = E " i
2] Ensemble Interoperate »
Ak rifas

BJMD. Prod. Praduction in

Synt roels)
) System Operation %Ens_Dashboard USE

' ’ Systemn Explorer

% System Administration

W Local intranet | Protected Mode: Off o R0k -

Figure 3-3: The System Monitor page is a sub-menu of the Ensemble Monitor menu.
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3.1.2 Namespace Selection

At the top center, many pages in the Management Portal display the server name, the
current user, the current namespace, license and instance information, and a Switch
link, as shown in Figure 3-4. To manage a specific namespace, click the Switch link.

e Unkmiowidlsed ariaed o Vangent. nc. Irstance. ENHS .
View D Saiion Management Portal
System Information
Welcome to the Management Portal
TREL RO S Paae pl e il o Systom Up Time
E " Did know? 16d 1h 54m
& Deepsee avon.e! '|'III\| LY::J I.,ulllrL" g
R 2 -« Enssmble Productions
@ Ensemble
BIMD.Prod. Praduction in

Figure 3-4: Switch link

In the Namespace Chooser box, select the appropriate MPI namespace. The
namespace will consist of "AGMPI" concatenated with the name of your RPMS
namespace. For example, if the RPMS namespace is called "PROD", then the
associated MP1 namespace will be called "AGMPIPROD". Click the OK button to
select the namespace. The namespace displayed on the Management Portal will be

updated to reflect the selection.

Ensemble 2012
Management Portal Manual
September 2013
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-
@ Namespace Chooser - Windows Internet Explorer - .Qlﬂlgj

. Namespace Chooser

Select a namespace

Available Namespaces
%SYS
C32G0LD1
DOCBOOK
ENSDEMO
ENSEMBLE
GOLD1
MJ2
SAMPLES
USER

If a namespace exists but is not listed, then you may not hold permission to
view it, or its database may not be mounted.

Cancel

ei\. Local intranet | Protected Mode: Off

Figure 3-5: Namespace Chooser page

3.1.3 Search Function

Many pages in the Management Portal have a Search function at the top of the
display area, as shown in Figure 3-6.

Server TNl Hamespace AGMPIGOLDY Swich

A O T e N M N Insiance EMHS.

Management Portal

Sean

-
\

\/% System Information

Home i ; g "

'y Welcome to the Management Portal
Ploase select one of the categoties on the (68 or one af the options bolow

Favorites Did you know?
o DeepSee Go 1o 8 favorie Dege o

You can vew the portal in a diferent languag :
by chking on the About bnk 8t the top of the  Ensembls Productions "
page and changing the preferred language.  Froductons g on

& Ensemble b
BJMD.Prod. Praductlon in

Figure 3-6: Search function

e To perform a function search in the Management Portal, enter the subject of the
search in the Search field near the top right of the page and then press Enter.

Ensemble 2012
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3.1.4 Management Portal Menu

Many pages in the Management Portal have a navigation menu on the left side of the

page, as shown in Figure 3-7.

= ]
Menu Haorme | About | Help | Logout
=EWEIRVDENMIHSDBDOT
f STEM

User. _SYSTEM
A Home Configure »
a Build »
View »
(J DeepSee List»
Monitor »
Manage »
Interoperate »
Test »

System Operation

' ’ System Explorer

’ System Administration

Figure 3-7: Management Portal menu

Use the options in the Management Portal menu to navigate to other pages required to

administer the current production instance.

- VT ENMIHS DEDY erpace AGHPIGOLDN 5w
Mk 1 Wangont, Inc.  BIHS
Search:
a [contqus - TR
joine Build » Business Partners
View » Credentials
€ oeepsee List» Schadde Specs
Manitor » Data Lookup Tables
L Manage » System Defaul Seftings
o Ensemble Interoperate » Message Bank Link
Test»
System Operation
i Y pe

Management Portal

Ensemble

System Information

Ensemble Productions

BJMD.Prod. Production in
CI2GOLM

Figure 3-8: The Management Portal menu options

¢ Home. Navigate to the Management Portal home page

o DeepSee. Options for managing DeepSee, InterSystems’s business intelligence

product

Ensemble 2012
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3.2

Ensemble > Configure. Defines and displays Production Configurations,
Business Partner Profiles, Credentials, Schedule Specifications, Data Lookup
Tables, System Default Settings, and Message Bank Link in the currently selected
namespace

Ensemble > Build. Design and builds Business Processes, Data Transformations,
Business Rules, Record Maps, and CSV Records

Ensemble > View. View Messages, Suspended Messages, Event Log, Business
Rule Log, Business Process Log, and connect to the Enterprise Message Bank

Ensemble > List. Display Business Processes, Data Transformations, Business
Rules, Record Maps, Productions list

Ensemble > Monitor. Monitor System, Production, Queues, and Jobs

Ensemble > Manage. Manage Emsemble System and workflow via Purge
Management Data, Auto-Start Production, Local Archive Settings, Workflows,
Publish and Subscribe

Ensemble > Interoperate. View and transform documents or import and remove
schemas such as ASC X12, ASTM, DICOM, HL7 v2.x, UN/EDIFACT, XML

Ensemble > Testing. Testing Service for Business Processes and Business
Operations, and Data Transformations

System Operation Options for the day-to-day management of the Ensemble
environment

System Explorer SQL portal, including Execute SQL Statements; options for
reviewing class, routine, and global data.

System Administration Configure namespaces and databases; manage users and
roles; manage licenses and encryption settings

Starting the Management Portal
To start the Management Portal:

1.

If Ensemble is not currently running, click the Ensemble Cube icon, as shown in
Figure 3-9, in the Windows system tray and select Start Ensemble from the
context menu.

Figure 3-9: Ensemble Cube icon

Click the Ensemble Cube and select Management Portal from the context menu.
If your site’s system security requires you to log in to Ensemble, the Ensemble
login page is displayed, as shown in Figure 3-10.

Ensemble 2012
Management Portal Manual Management Portal
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tride Tt

Figure 3-10: Ensemble login page

Note: Login for Ensemble may not be a requirement at your site.

If the login page is displayed, type your User Name and Password and click Login
to open the Management Portal, as shown in Figure 3-11.

Leru Home | About | Heka | Logout

Welcorme, _SYSTEM User _SYSTEM Licomsnd b Vanget, nc. Instanci: E3HE b ko m
View: D . Seatch: Management Portal

System Information

Hi :

m e Ll \Welcome to the Management Portal i Syt pisoa

Please select one of the cateqories an the I8 or one of the options below S o Tk
i ? 164 2h 31m
o DeepSee Fa\rurl.[ea Did you know? h

Ji{i‘J Ensemble Productions

& Ensemble <:

' System Operation

Recent

u ' System Explorer EnsemblaMonitor

Praduction Configuration

S
’f' System Administration
S Local intranet | Protected Mode: Off v Kok -

Figure 3-11: Management Portal page showing the Home and Ensemble links
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3.3 Ensemble Production Page

As shown in Figure 3-12, the Ensemble menu contains sub-menus that link to
different Ensemble functional areas.

Leeru Home | About | Heka | Logout
K Sonvr UL ARl HAmespace AGMPIGOLDT SwEch
Usier Dnhnownllies  Liconsed by Vangent, bc. Instanc E3HS o Bt S ystem
View: D Seatch: Management Portal
Configure » System Information
A. Home e ata
View » System Up Time
(J DeepSee List » 164 2h 39m
_Mn_rup_)_r » | Ensemble Productions
Manage » g '
Ensemble -
o IanmiwmlP_» | BLIMD, Prod Production in
Tests CI2GOL
- Sioppad
System Operation
) Y pe
“ ’ System Explorer
‘ System Administration
N Lol intranet | Protected Mode: Off v RN -

Figure 3-12: Management Portal page

e Use the menu on the left side of the page to navigate to other pages required to
administer the AGMPIxxx production instance.

Note: Some pages in the Management Portal do not have a menu
located on the left side. On these pages, return to the
Management Portal home page by clicking the Home
navigation link located at the top of the display area, as
shown in Figure 3-12, and use the menu on the home page.

3.3.1 Choosing a Namespace
The Switch link appears at the top of the display area, as shown in Figure 3-13.

Gerver (GUEIEEAEE] Mamespace AGMPIGOLDY Switch <
Liger Uniknowniises Licensan b0, Vandgenm, Inc, riEtance EMIS e

Saarch: | ] Management Portal

A Configure » System Information
Home o . :
] Burld =
Vlew‘—. System Up Time
164 2h
o DeepSee List»
Monitor Ensemble Productions
n Manage » i
* Ensemble |
O St FIMD Prod Praduction in
Test » CI2GoLM

System Operation

Figure 3-13: Switch link
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1. To begin working with the Ensemble options, select the appropriate namespace.
At the top center, the main Management Portal page displays the server name,
the current user, the current namespace, license and instance information, and a
Switch link.

2. Click the Switch link.
3. In the Namespace Chooser box, select the appropriate MPI namespace.

e The namespace will consist of AGMPI concatenated with the name of your
RPMS namespace.

e For example, if the RPMS namespace is called PROD, then the associated
MPI namespace will be called AGMPIPROD.

4. Click the OK button to select the namespace. The namespace displayed on the
Management Portal will be updated to reflect the selection.

r ™
@ Namespace Chooser - Windows Internet Expm ‘E'I_ﬂlg‘

Namespace Chooser
. Select a namespace

Available Namespaces
%SYS
C32G0LDM1
DOCBOOK
ENSDEMO
ENSEMBLE
GOLD1
MJ2
SAMPLES
USER

If a namespace exists but is not listed. then you may not hold permission to
view it, or its database may not be mounted.

Cancel

€ Local intranet | Protected Mode: Off

Figure 3-14: Namespace Chooser
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Note: During the AGMPI installation process, a namespace called
AGMPIxxx was created, where “xxx” is your production
namespace. Work in this namespace when using this
manual.

The Ensemble installation procedure creates several
namespaces for internal use by the Ensemble engine:
%SYS, DOCBOOK, USER, SAMPLES, ENSEMBLE, and
ENSDEMO.

All system-provided namespaces except ENSEMBLE and
USER are overwritten upon reinstallation or upgrade. For
this reason, InterSystems recommends creating new
namespaces, rather than placing custom code in any of the
system-provided namespaces, where it could be overwritten
and lost.

3.3.1.1 Opening the AGMPI Namespace Production
1. Atthe Management Portal, click Ensemble.

2. Select Configure, then click Production.

8 E3IHS - Hame - Windows

m---:ﬁ bt/ /1024196 A3 STTTS/ cep/ agmpigaldL FR2SC5P Partal Home ten w4y | x B0 Google o)

x @ Comvent = [0 Select

% Google = £ Search = B shace (L= More 3 Signln W, -
d Fevcites | g ) iBank Veniond @) Microsoft Exchange - Outl., | Delvek Tome & Bxpense - — @8 Suggested Sites = 1] Web Siice Gallery =
4y E31H5 - Home B - B - # - Bager Sty Tgohr @
Search: | ] Management Portal
Build » Business Partners o G
View » Credentials System Up Time
" y DeepSee List » Schedule Specs 17d 14 49m

Monitor » Dala Lookig Tables Ensemble Productions
- ‘Manage » | System Defautt Settings I
|“l!5ruperale » | Message Bank Link A agistration in
Test » L

o an in

System Operation
P y P

‘ ' System Explorer

? System Administration

ittpc//10.24 196 A3STTTS s/ bgmpegoldl %25CSP Portal Home sens € Localintranet | Protected Mode: OFF v Roos v

Figure 3-15: Production Configuration screen

The Production Configuration screen will update to display the items for the
MPI production, as shown in Figure 3-16.
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3.3.2

x @Convert v [ Select

% Google = |4 Search - Elisnm Mere 30 Signin &, -
i Favortes | 4 @) iBank Versiond @8] Mecrosolt Exchange - Oull.. @ Deltek Tome & Expente - . @8 Suggested Sites = @] Web Shoe Gallery =
£ Production Configurstion fiv @ -0 dm o~ Bager fufey Tgoke @ 7
[‘vaenu | Horne | Aot | Hesn | Lopout Ensembile » Producton Configuration s
= Server TUTLITTT] Hanmiecpacs AGMPIGOLDT Swilcl
- L User WnknownUses  Licensed o Vaige. inc. Instance ENHS Ly nterSysteme
View: €Y Refresh: ©0n & off Sot: N Status  Mumber "
L ~ irlresh ame Hus ul m“m mnmmnm
Catagory Al = Legend  Production Settings Production Settings
Services + Processes * Operations = e
@ MPibound @ AGMPILMF '] [ ]
@ RPMSInBouna @ AGMPL DE n ¥ @ Search
i Ens Alen @ MPICuRBound
@ RPMSOutBoung
» Informaticnal Senings |
- Rasic Semings
Actor Poal Size
2 o
= Additicnal Serings
Shutdown Timeout
120
Updats Timesut
0
r Development and Debugging 1
Dene W Locstintranet | Protected Mede: Off i v Kok -

Figure 3-16: Management Portal page showing the AGMPI.PatientRegistration production
configuration

Production Configuration Page

The Production Configuration screen will display the items for the currently
running MPI production, as shown in Figure 3-17.

75/ cup/agmpigeddl EniPortal ProductionConfig ren

= Google = | 20 Seasch - szgﬂ More 3 Signin &, -
o Favortes | o @ iBankVersiond @ Microsoft Buchange - Outl., @ Deftek Time & Dopente - . (@8 Suggented Stes = @) Wab Slce Gallery =
| production Configuaton =i B8O b ey Tk O 7
= Horn | About | Helg | Logaut Gnsembie » Produrtian Configuration -
Senvr (ECTIEIEN Hamespace AGMPIGOLDY Swach
lon User Unhnowitiser  Licensed 1o Viangent. Inc, Instanc e ENHS ey i Tyshers
) Refrash: ©on @ oft Sorc Name Status  Number
| | et i Production Configuration
Catogory- All +  Legend  Production Setrings Production Settings
Services *© Processes * Operations * ing:
@ MPlnbound @ AGMPL 0 ®
@ REMEInBouny @ AGMPI g @ v @ Search
@ Ens Adert @ MPIQuiBound _ .
@ RPMSOutBound y

v Informational Settings

~ Basic Settings
Actor Pool Size
2

= Additional Seftings
Shutdown Timeout
120

Update Timeout
10

» Davelopmaent and Dabugging

Dene lemwmmmw v RI0% -

Figure 3-17: AGMPI.PatientRegistration production configuration
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The production configuration diagram is a graphical inventory of the business hosts in
the production, organized into three columns: Services, Processes, and Operations. At
the top left above the column headings, the diagram shows a production status
message.

Each production item has a circular status indicator next to its name. This indicator
changes color with the status of the production item it represents. Click Legend to see
the meaning of the status indicator values along with hints on other ways to interact
with the production configuration diagram, as shown in Figure 3-18.

/€ Production Configuration Legend - Windows Internet Explorer E = @

o Production Cenfiguration Legend

Indicators

() Mot running, enabled
@ Running
() Disabled
@ Error
) Inactive
Interaction
Click on an item's name to view its details
Click on an indicator to view the connections

Double-click on an item to enable or disable it

oK

Figure 3-18: Production Configuration Indicators

The following fields appear on the Production Configuration page:

e Production Name. The name of the currently running production or the last
production run.

e Production Running (or another status). This field describes the status of the
Ensemble execution engine. The status “Running” appears if any Ensemble
production is running. Otherwise, “Production Stopped,” “Production
Suspended,” or “Production Troubled” appears.

e Stop Production. Depending upon the status of the production, the button above
the Production field may appear as Start Production, Stop Production, Update
Production, or Recover.
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To start, stop, update, or recover the production listed in the Production field, click
Start Production, Stop Production, Update Production, or Recover. The button
will have one of the following labels:

Start Production. The Start Production button is available only if no production
is currently running. Click Start Production to start the production listed in the
Production field.

Stop Production. The Stop Production button is available only if a production is
currently running. Click Stop Production to stop the production listed in the
Production field.

Update Production. The Update Production button becomes available on the
Production Configuration page when there is a discrepancy between the status
of the currently running production and the production as defined in the code:

a. Click Update Production to update the production and resolve the
discrepancy.

b. When the confirmation message is displayed, click OK to return to the
Production Configuration page.

Examples of discrepancies include the following:
— A specific business host experienced an error and has died (the most likely
cause).

— The user changed a configuration parameter for a business host in a
running production, so that the host now needs to be restarted.

— A production opens a Terminal window, but this window was closed by a
user action while the production was still running.

Recover. Click to recover a production with a troubled status; this cleans up the
troubled instance of the production so that you can run a new instance when you
are ready.

Note: Detailed instructions for configuring a production using the
configuration diagrams are found in the Patient
Registration (AG) MPI Interface/Ensemble Installation
Guide and Release Notes.

For the purposes of this manual, use the
AGMPI.PatientRegistration production instance.

Production items. Below the Stop Production button are the Business Services,
Business Processes, and Business Operations that make up the production.
These are discussed in more detail in the Patient Registration (AG) MPI
Interface/Ensemble Installation Guide and Release Notes.
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3.3.3  Checking Production Status

Upon successful login, check to make sure that the production instance is still
running, and that there is no warning message listed next to the production name.

Note: Always monitor Outlook e-mail for alerts from Ensemble.
See Section 10.0 for information about Ensemble e-mail
alerts.

If more than one Ensemble namespace is available, be sure that the appropriate
namespace is displayed in the Namespace field.

Note: If only one Ensemble namespace is available, the login
page automatically selects that namespace.
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4.0 Working with Productions

4.1 Production Status

A production may be in any one of the states listed in Table 4-1.

Table 4-1: Production Status Values

Status
Value

Meaning

Running

When a production has been started and is operating normally, it has a
status of running and its row on the Production List page, as well as the
status message above the production configuration diagram is green.
Running is an acceptable state.

Stopped

A production acquires a status of stopped when, at the end of the shutdown
sequence, all of its queues are free of synchronous messages. This is an
acceptable state. The status message above the production configuration
diagram for a stopped production is gray.

Suspended

A production acquires the suspended status if, at the end of the
shutdown sequence, some queues still contain synchronous messages,
waiting for a response. Depending on how the production has been
designed, this may or may not indicate a problem. The status message
above the production configuration diagram for a suspended
production is yellow.

You may start a suspended production. Starting the production again
may permit the waiting messages to be processed. However, if you
start the suspended production, and more messages arrive while those
in front of them in the queue cannot be resolved, queues may simply
continue to fill. In that case you must investigate to discover why the
incoming messages never complete.

Troubled

A production acquires a status of troubled if Ensemble is stopped but
the production did not shut down properly. This can happen if you
restarted Ensemble or rebooted the machine without first stopping the
production. The production row on the Production List page is
highlighted in purple. The status message above the production
configuration diagram for a troubled production is red.

When a production acquires a troubled status, a Recover command
appears in the ribbon bar on the Production Configuration page for the
production. Click this command to clean up the troubled instance of
the production so that you can run a new instance when you are ready.
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4.2

4.2.1

Any changes made to a production while it is running are applied immediately,
without requiring the stop and restart of the production. When a production is
running, monitoring and diagnostic tasks can be performed from the Management
Portal.

Production List Page

The Production List page, shown in Figure 4-1, lists all the productions defined in
the current namespace and provides status information and links for configuring,
exporting, deleting, and inspecting each production.

Only one production may run in a namespace at a time. However, if multiple
productions are defined, any production on the list can be managed from this page.

Menu Hoine | About | Hetg | Logout Ensambie = Frodutson List
Senvor TUEICIEAET] Namiespacy: AGMPIGOLDY Swilch

\TIFNMIHSTIA
Production List I Unknowiises vai I Vangent, e, Fstane s ESHS

AGMPL PafientRegistration Troubied 2012-12-07 120452 855

Figure 4-1: Production List page

Configuration pages for each production can be accessed from the Production List
page. Configuration settings affect the behavior of the production, as well as the
various configuration items within the production, such as business services, business
processes, and business operations.

Note: Detailed instructions for using a production’s configuration
pages are found in the Patient Registration (AG) MPI
Interface/Ensemble Installation Guide and Release Notes.

Opening the Ensemble Productions Page
To display the Production List page from the Management Portal:

1. click the Ensemble menu.
2. Click the List sub-menu.

3. Click Productions, as shown in Figure 4-2.
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Wenu w | Alzoist | Hiedo | Lagout
onvr VETICEEAR] Mamespico AGMPIGOLDY Sitch
User: UniknownUser.  Licensad fo. Vet e, Instance EIS L -
Search Management Portal
P . Configure » Business Processes System Information
Home Build » Data Transformations
View » Business Rues Sy Up Thoe
Maontor » Froductions Ensemble Productions
Manage » | Cick this item for sddaional options or detalls, ' .
o Ensemble Interoperate » T
Test »
System Operation
w Y B
" ’ System Explorer
?" System Administration
hitpo/710.24 196 AXSTTTS/ csp/ eampigohdl/H25CSP Portal Home.zens & Local intranet | Protected Mode: Off - Roox -

Figure 4-2: Productions menu option on the Management Portal home page

The Production List page is shown in Figure 4-3.

e Huorne | About | Heda | Logaut Ensembie > Froduckon List
Server (U RG] Mamiespace AGMPISOLDY Swilch

J roduction List User Unkaowiises Icomis 0 Vatgen, Inc. Irsbance ESHS

New § Open | Export | Delste § Document Production List
[ New | Open | Expart | Delste | Docimmen |

Productian Hame Statu: L
AGMPLPatientRegistration Troubled 2012-12-07 120452865

Figure 4-3: Production List page

In addition to the list of productions in the current namespace, the Production List
page contains the Server, User, Namespace, License, and Instance information at the
top center of the display area.

e To manage a specific production, select it in the production list and click Open.

e To navigate to a different page in the Management Portal, return to the
Management Portal home page by clicking Home at the top of the page.

4.3 Production List

The Production List page displays a list of the Ensemble productions that are
defined in the current namespace:

e Use the page to navigate to a specific production in the list to configure, stop, or
start it.

e View the Production List page of the Management Portal by clicking
Productions on the Ensemble List menu.
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Above the list of productions are five buttons:

Click New to start the Production Wizard to create a new production in this

namespace.

Click Open to display the Production Configuration page for the selected
production. This is a graphical inventory of the business hosts in the production,
organized into three columns: business services, business processes, and business
operations. Each item in the diagram displays runtime status indicators. You can
select individual elements to monitor and edit the details of performance and

configuration.

Click Export to export the selected production.

Click Delete to remove the selected production from the namespace.

Click Document to view or generate configuration documentation for this
production in HTML format.

© Production Statut - R ® - Esge- Juey~ Tgoh- @~
Mo | I I . __
Server ULl Mamesoaece ACMIGOLDY Switch Ensemble
Production List Ui Unknowiliser Licersud o Vangen, e, 4 o ENHS sl
['New ] Oven ] Eevor ] Dot ] Document | Production Lis

AGMPLPatieniRegistration Running 3013.12.04 07:24:13.080

Figure 4-4: List of productions on the Production List page

The color of each row indicates the status of the production, as specified in Table 4-2.
See Section 4.1 for information about the production status values.

Table 4-2: Colors associated with production status

Production Status Row Color
Running Green
Stopped Gray
Suspended Yellow
Troubled Red

Under the Production List page ribbon bar is a table that lists all the productions
associated with the currently active namespace. Each row is devoted to one
production and has the following columns of information:

Production Name. The name of the production.

Status. The status of the production: running, stopped, suspended, or troubled, as
described in Table 4-1.

Last Start Time. The date and time when the production was last started.

Last Stop Time. The date and time when the production was last stopped.
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4.4

4.4.1

Note: Detailed instructions for configuring a production using the
configuration diagrams are found in the Patient
Registration (AG) MPI Interface/Ensemble Installation
Guide and Release Notes.

Starting and Stopping a Production

Only one production can be run in a namespace at a time. If a production is running
and a user tries to start a different production in this namespace, a warning message is
displayed and nothing changes.

e To start a different production, stop the currently running production on the
Production Configuration page, and then start another one.

Start a Production Manually
To start a production from the Production Configuration page:

1. Click Start and answer OK to launch the Start Production dialog. It displays the
name of the production, its startup status, and any messages associated with
production startup.

2. When the startup dialog shows it is Done, click OK at the bottom of the dialog.

You can stop the running production and start another one from the Production
Configuration page. If you try to start one, and another is already started, a warning
message displays and nothing changes. For example:

12:05:06.292:Ens.Director: ERROR Ens>ErrProductionAlreadyRunning:
Production "Demo.Loan.FindRateProduction® is already running
12:05:06.352:Ens.Director: ERROR Ens>ErrProductionAlreadyRunning:
Production "Demo.Loan.FindRateProduction® is already running
Production "Demo.Loan.BankUSProduction® not started:

ERROR <Ens>ErrProductionAlreadyRunning: Production
"Demo.Loan.FindRateProduction® is already running

Note: Detailed instructions for configuring a production using the
configuration diagrams are found in the Patient
Registration (AG) MPI Interface/Ensemble Installation
Guide and Release Notes.

3. In the confirmation dialog box, click OK to display the Start Production page, as
shown in Figure 4-5. The Start Production page includes the name of the
production, its startup status, and any messages associated with production
startup.
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-
Message from webpage ' u

| Do you wish to start this Production?

| ok || cancel

Figure 4-5: Start Production confirmation dialog box

Note: If any Terminal windows are displayed during production
startup, do not close them manually.

o
/& Start Production - Windows Intemet Explorer =g

O Start Production

Starting Production: AGMPI.PatientRegistration

08:51:03.172:Ens.Director: Production 'AGMPI.PatientRegistration' starting.

08:51:04.422:Ens.Director: Production 'AGMPI.PatientRegistration' started.
Done. < ’:

Done € Local intranet | Protected Mode: Off dh v H10% v

Figure 4-6: Start Production page

4. When the Status field at the top of the page displays Done, click OK.
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4.4.2

Stop a Production Manually

Stop an Ensemble production from the Production Configuration page by
performing the following steps:

1. Click Stop and answer OK to launch the Stop Production dialog. The Stop
Production dialog displays the name of the production, its shutdown status, and
any messages associated with production shutdown.

. T N
Message from webpage I,&J

l:g] Do you wish to stop this Production?

[ 0]4 l | Cancel

b

Figure 4-7: Stop Production confirmation dialog box

2. When the Stop Production dialog indicates it is Done, click OK.

3. If the request to stop the production initially fails, the portal displays the message
Production could not stop, do you want to force a shut down? Click Yes -
Force to Shut Down to force the production to shut down.

In the portal, you can only stop a production if it is open for configuration and it is
running. You will receive an informational message if you try to stop a production
that is not running or try to start a production and another production is already
running in the namespace. You must open the running production in the Production
Configuration page before you can stop it.

Note: Detailed instructions for configuring a production using the
configuration diagrams are found in the Patient
Registration (AG) MPI Interface/Ensemble Installation
Guide and Release Notes.
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5
& Stop Production - Windows Internet Explore: [
—

O Stop Production

Stopping Production: AGMPI.PatientRegistration

20:40:10.169:Ens.Director:
20:40:14.8%03:Ens.Director:
20:40:14.8%03:Ens.Director:
20:40:14.8%03:Ens.Director:
20:40:15.013:Ens.Director:
20:40:15.044:Ens.Director:

Production not stopped:

StopProduction initiated.

Could not call OnProductionStop() on nonexistent
Could not call OnProductionStop() on nonexistent
Could not call OnProductionStop() on nonexistent
Production 'AGMPI.PatientRegistration' stopped.
ERROR <Ens>ErrException: <CLASS DOES NOT EXIST>:

ERROR <Ens>ErrException: <CLASS DOES NOT EXIST>zStopProduction+557Ens.Direc

Production could not stop within 120 seconc

[

‘Yes - Force to Shut Down I

oK I

?'l, Local intranet | Protected Mode: Off

a v ®mI0% <

Figure 4-8: Stop Production page

4.4.3  Start and Stop a

Production Automatically

The Auto-Start Production page allows you to configure Ensemble so that a specific
production starts automatically at system startup and stops automatically at system

shutdown.

B = B - 00 @ - Page- ey~ Tgok- - 7
User Wnbaiowillser  Licensed lo: Viangent. Inc., Instance EMIS oy K Tyiter
Search: Management Portal
Configure » Purge Management Data System I.nlom1.ah'on .
. Home Build » Auto-Start Production i S s g
View » Local Archive Manager [ Cieck this item for addtional options of detaibs. beyom Up Time
o DeepSee Ligt » Workflow » 17d 17h 30m
Monitor » Publish & Subscribe Ensemble Productions E
Ensemble
O Interoperate » AGMPI.PatientRegistration in
Test» AGMPIGOLDY
System Operation ook
' ¥! Pe BJIMD . Prod Productlon In
CI2GOL0T
5n i
' ' System Explorer
¢ System Administration
hietp/ 710,24 196, %550 zend S Local intranet | Protected Mode: Off v Blo% -

Figure 4-9: Auto-Start Production option

1. On the Management Portal menu, click Ensemble.
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2. Click Manage, then click Auto-Start Production to open the Auto-Start
Production page, as shown in Figure 4-10.

£ Ausc-Saart Production -8 - s v Page= Gafety = Tgoh = =

Ensemble
Swch

stance E3MS

=P NS DEDO
ser Unkmownllss u

Auto-Start Production

Choose a production to stan automatically on Ensembie startup, then cliick Apply

I =

AGMPA PabentRegistration

Figure 4-10: Auto-Start Production page

3. Inthe Auto-Start Production list, select a production to start automatically at
system startup and stop automatically at system shutdown. To disable automatic
production start and stop, click the blank entry.

4. Click Apply.

4.4.4  Ensemble Manage Menu

Use the Ensemble Manage menu for cleanup operations, such as purging outdated
records, specifying automatic startup for a specific production, managing local
archives, managing workflow (roles, users, tasks, worklist), and defining publish and
subscribe settings.

o I Home h-a - #m v Pagew Sefety~ Toch~ @~ 7
1 # | Aboul | |
Uger. Unknownllges Licumsud o Vangest, nc. nstance EXNHE e
Search: ] Management Portal
. Configure » System Information
Home - ; :
'] Build » Dl
Vlew 2 } System Up Time
(, DeepSee List» L i
Monitor » Ensemble Productions
[ Manage = x
) Ensemble iteroperate » ]
Test»
System Operation
w in
]’ ' System Explorer
? System Administration
hetp://10.24 196 A35TTT5/ csp/ sgmpigodL/%25CP Portal Home 2en® S Localintranet | Protected Mode: OFF v Riw% -

Figure 4-11: Ensemble Manage menu
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On the Management Portal menu, click Ensemble, then click Manage to open the
Manage sub-menus, as shown in Figure 4-12.

Figure 4-12

o E3IHL - Home B~ Bl 5 #m ~ Bege~ Sefety~ Tgch~ i

gor_ Unknormiser Uceneed o Vangens, ic. natance EMHS

Swarch: | Management Portal

Configure » Purge Management Data System I.nlarmatian .
Bulki.; | Aui‘(s.Slarl Pr‘u(‘lu:lun | omn
.VIQU;'. » [ L-c;E:.z.h;\r.c-hl.\-c M;':n:.:gcr
List » Workdlow »

Monitor = Publish & Subscnbe

Interoperate »

O Ensemble

Tests

System O i
wp SYstem Operation

y ' System Explorer

g System Administration

& Local intranet | Protected Mode: OFf G- Hwom -

Figure 4-12: Ensemble Manage page

The Manage menu contains the following options:

Purge Management Data. Purge messages, logs, and monitor records

Auto-Start Production. Configure Ensemble to start a specific production
automatically at system startup and to stop the production automatically at system
shutdown

Local Archive Manager. Define or run local archives
Workflow. Create, view, or edit workflow roles, users, tasks, and worklists
Publish and Subscribe. View or edit Subscriptions, Domains and Subscribers
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5.0 Purge Management Data Page

The Purge Management Data page allows you to delete outdated entries from the
event log, message warehouse, business process log, business rule log, and 1/0
archive log. You can only purge entries associated with the active namespace. To
navigate to this page, click Purge Management Data on the Ensemble Manage
menu. Only entries associated with the currently running production can be purged.

To open the Purge Management Data page:
1. On the Management Portal menu, click Ensemble, then click Manage.

2. On the Manage sub-menu, click Purge Management Data to display the Purge
Management Data page, as shown in Figure 5-1.

£ Purge Management Dats I o v Pagev Sefetyw Tpokiv v

Sorer e TCTEE Mamespac o AGRPGOLDY el
ar Unknowniliser Licanzad 0 Viangent, nc. nstance EMHS

Purge Management Data

Figure 5-1: Purge Management Data page

If a purge operation is not currently running, the Start Purge button is displayed. If a
purge operation is running, a highlighted row displays the status of the operation.

The following status information appears in the display area:

e Type of Record. Each row in the table lists one type of artifact that the currently
running production is producing on an ongoing basis (Event Log, Messages,
Business Processes, Business Rule Log, and I/O Archive).

e Count. Total number of entries of this type stored for this production. Use the
Count to decide whether or not it is worthwhile to purge the records and if so,
how many days’ worth of records you want to keep.

e Delete. Total number of entries of this type that the purge operation deleted after
you click Start Purge and the purge completes.
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5.1 Starting a Purge Operation

To start a purge operation, perform the following steps:

1. Select the Include message bodies check box.

If this check box is selected, Ensemble will purge associated message bodies
along with message headers. Ensemble verifies that body classes exist and are
persistent before purging them.

If this check box is cleared (the default setting), message header data is
purged, but message body data is retained.

2. Clear the Keep data integrity check box.

If this check box is selected (the default setting), a message will not be deleted
unless its status is Complete, even if it meets the age criterion for purging.

Ensemble considers messages to be complete if they are marked Complete,
Error, Aborted, or Discarded.

This option is important to support long-running business processes. Usually
this is the desired behavior. However, if there are old messages in the system
whose incomplete status is not significant, it may be time to purge the
messages.

To purge old messages whose incomplete status is insignificant, uncheck the
Keep data integrity check box.

Note: To delete messages, Include message bodies must be

selected and Keep data integrity must be deselected.

3. Inthe Do not purge most recent box, type the number of days of records to
retain.

The default setting for Do not purge most recent is “7,” which retains
records from the past seven days.

If this setting is 0 (zero), no messages are retained, and all entries that exist at
the time of the purge operation are deleted.

The specified number of days includes “today,” so keeping messages for one
day keeps the messages generated on the current day, according to local server
time.

4. Click Start Purge:

When this button is clicked, Ensemble immediately purges the persistent store
according to the settings specified on the Purge Management Data page.
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e The purge operation runs as a background job, and the Purge Management
Data page displays a highlighted row describing the status of the purge
operation.

Note: The Start Purge operation cannot be undone.
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6.0

6.1

6.2

Credentials Page

About Credentials

Some remote systems require a username and password to log in. In Ensemble, a
username/password pair can be stored as a “login credential.” Ensemble then uses the
login credentials in place of the username and password to access the remote system.

Ensemble stores login credentials in a centralized table that can be viewed and edited
only by users with access to the Management Portal. Credentials are managed from
the Credentials page, which is accessed by clicking Credentials on the Ensemble
Configure menu. The Credentials table, shown in Figure 6-1, allows credentials to
be managed easily and protects login data from unauthorized access.

0 Credentish T T B # - Pige~ ey~ Igoh~ W~

Men I Ao Helo | Logout ambla » Cradentia
Terver UGkl Mamespace AGMPIGOLDY Swich Ensemble
Covernas | User r Lianaests vangeeme. e EXS

Credentials Viewer

1] User nam : Password Business Partner
AGMPiAlerts SuUperuser oo

Figure 6-1: Credentials table

Each entry in the Credentials table has an ID which is used as the value of the
Credentials setting when configuring production items that require logging in to a
remote system. Adding an entry to the Credentials table for a production consists of
assigning an ID to a username/password pair. You can also store an informational
business partner name with the credential.

How Credentials Are Used

Some adapters in an Ensemble production use login credentials to log in to remote
systems. Using an ID supplied during configuration, an adapter retrieves the
username and password from the Credentials table, and then sends them to the remote
system with a request to log in.
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6.3

When a production is being configured, the 1D for the appropriate user’s credentials
must be entered on the configuration page for each adapter that requires credentials:

e If the Credentials field is present on an adapter’s configuration page and the
remote system requires authentication, then the adapter must contain an ID from
the Credentials table. The adapter will not function without the credentials.

e |f the Credentials field is not present, the adapter does not use credentials to
access a remote system.

Note: Detailed instructions for configuring a production using the
configuration pages, including specifying credentials for
adapters that require them, are found in the Patient
Registration (AG) MPI Interface/Ensemble Installation
Guide and Release Notes.

Creating and Editing Credentials

If the Credentials table does not contain an appropriate entry for a particular adapter,
a new login credential must be created. Credentials can only be created or edited by
logging in to the Management Portal and navigating to the Credentials page.

The Credentials page displays a list of defined credentials associated with the current
namespace. Each row in the table has the following columns:

e ID — Unique string that identifies this username-password pair; the name you use
in the Credentials setting when configuring a business service or business
operation to establish a remote connection.

e User name. Username with which to log on to the remote system.
e Password. Password corresponding to the username.

e Business Partner (optional). Name of the business partner profile associated with
this item.

When editing a credential, you can choose a business partner from the list and view
its details by clicking the magnifying glass. You can also create or edit a profile by
clicking the Business Partners Configuration Page link.
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When you select a credential by clicking on its row in the table, the Credentials
Viewer pane displays the current settings. If you do not select a credential, the right
pane shows empty fields for you to create a new credential. Enter values in the fields
as outlined in the table description. You have the choice of two actions to perform in
the Credentials Viewer:

e Click Save to store the updated or new values as a credential and display it in the
table. If you choose to edit a row and change the 1D, when you click Save, you
must verify that you want to rename the credential.

e Click Remove to delete the selected credential.

Note: You cannot undo the Remove operation.
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7.0 Messages and the Message Browser

7.1 About Messages

All communication that passes between configuration items in Ensemble is
accomplished using messages. Each message has a header, which contains data fields
that help route the message through the system; all message headers contain the same
data fields. Each message also has a body, which includes different fields depending
on the message contents.

Each message belongs to a specific message class, which may be either a request
class or a response class. While every response class is conceptually paired with a
request class, there may be request classes that do not have a corresponding response
class defined.

A request class may be synchronous (waits for a response) or asynchronous (does not
wait) in its implementation. This decision is made by the class developer, and it is not
configurable in a completed production.

Ensemble offers some built-in message classes to handle specific types of message
content, and other message classes may be defined by class developers to fulfill a
specific production need.

Complete tracking information is stored in the Ensemble message warehouse for all
instantiated messages. This information is available at all times on the Message
Viewer page and the associated pages devoted to messages.

7.2 Managing Messages in Ensemble

Messages are the primary currency of action and communication within Ensemble; so
many management tasks are associated with messages. Table 7-1 lists the Ensemble
tasks related to messages and the navigation sequence from the Management Portal
page to the relevant pages.

Table 7-1: Message tasks in Ensemble

Message Task Navigation Sequence
Filter and view messages in various ways. Message Viewer
Filter the message log for the currently running Message Viewer, Filter

production by entering search criteria such as time
of day or session identifier.

View message body contents. Message Viewer, Contents
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7.3

Message Task

Navigation Sequence

View message header contents for a message.

Message Viewer, Header

View message body contents for a message.

Message Viewer, Body

Periodically save older messages to a separate
archive for long term storage.

Manage, Local Archive Manager

Resend selected messages.

Message Viewer, Resend

View messages that have entered a Suspended
state. Resend selected messages.

View, Suspended Messages

View a visual trace of the delivery of a message,
from original source all the way through to
fulfillment (or failure).

Message Viewer, Trace

Test HL7 or X12 messages, by viewing and
transforming them.

Interoperate, HL7 v2.x, HL7 v2.x
Message Viewer

Interoperate, ASC X12, ASC X12
Document Viewer

Test a production by sending request messages
and receiving responses.

Test, Business Hosts

Message Viewer Page

The Message Viewer page lists messages that the Ensemble production has sent or
queued and provides tools for filtering, inspecting, and managing the messages.

To open the Message Viewer page, navigate to the Management Portal home page
and click Ensemble, then click View, then click Messages. The Message Viewer

page is shown in Figure 7-1.
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7.3.1
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Figure 7-1: Message Viewer page

The Message Viewer page contains three panes:

The left pane contains fields for searching, sorting, and filtering the messages in
the message list.

The center pane contains the message list, showing all messages in the persistent
message store for the currently running namespace.

The right pane displays details about a message selected in the center pane.

The panes on the left and right may be hidden to provide more display space for the
remaining panes. To hide a pane, click the pane’s corresponding double angle
quotation (<< and >>), as shown in Figure 7-2.

Home | About | Help | Logout Ensemble = Message Viewer
Server S EEBEIER MNamespace: AGMPIGOLD1 Switch
1 User UnknownUser Licensed to: Vangent, Inc. Instance E3HS

¥

Sort Order Page Size [ D Time Created Session Status Error Source Target i . Header | Body | Contents | Tracq

Newest First ~ 100 ~ . .
. [l 33 12:08:00.432 22 Completed OK  RPMSInBound AGMPIL.RPMSMessageRoL Details for selected item
JumelEorm- Er2 [ 31 120754916 20 Completed 0K RPMSInBound AGMPIRPUSHessageRal
Time Only ~ 1
[ 29 12:07:44.432 328 Completed OK  RPMSInBound AGMPLRPMSMessageRoL
~ Basic Criteria [] 27 1207:38.916 27 Completed OK  RPMSInBound AGMPILRPMSMessageRoL

Figure 7-2: Buttons to hide the left and right panes on the Message Viewer page

Message List

The message list in the center of the Message Viewer page includes the following
columns:

Check box. Select messages for the Resend button.
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ID. The unique identifier for the instantiated message; the object identifier
(<Objectld>) of the message header.

Time Created. The date and time when this message was instantiated.

Session. The unique identifier for the session that is (or was) associated with this
message. A session marks the beginning and end of all the activities prompted by
a primary request message from outside Ensemble. The primary request message
has an ID value that is identical to the Session. Several additional messages may
be instantiated within Ensemble during the session to fulfill the primary request.
All of these messages share the same Session, but each has a different ID value.

Click the Session number in any row of the table to see a visual trace of the
message object through the production. See Section 7.3.5 for more information
about the Ensemble Visual Trace page.

Status. The status of the message within its normal life cycle. Status values are
Created, Queued, Delivered, Deferred, Completed, Discarded, or Suspended.

For a request/response pair, the value does not indicate an overall status for the
pair; a request may end up with a different status from its corresponding response.

A message in transit has a status of Created, until it is placed on a queue, at which
time it has a status of Queued. A message that reaches its destination has a status
of Delivered, then Completed. An asynchronous response has a status of
Discarded if the response arrives after the timeout period for the corresponding
request expired. A message response can be deferred by a business operation and
be sent later on; when a message with a status of Deferred is finally sent, it has a
status of Completed.

Some business operations are designed to set the status of any failed messages to
Suspended. Such a message is moved to a special queue where Ensemble keeps
all suspended messages. An administrator can use the Suspended Messages page
to examine suspended messages, diagnose problems, and, if possible, resend
suspended messages after the problem is fixed.

To open the Suspended Messages page, navigate to the Management Portal
home page and click Ensemble, then click View, then click Suspended
Messages.

Error. The results returned by the message to the configuration item that sent it.
Possible error values are:
— OK, indicating normal behavior

— Retry, indicating the message experienced a failure but the system is
configured to retry sending the failed message
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— Error, indicating an error was reported somewhere in the activity

— Inactive, indicating that the item that sent the message has been idle for
longer than its Inactivity Timeout setting, and may require diagnostic action

When filtering messages for diagnostic purposes, use the Error field to quickly
select only those messages with errors.

e Source. The configuration item (business service, business process, or business
operation) that sent the message.

The right pane includes the following tabs that display additional message
information:

e Header. Displays the fields in the message header object.
e Body. Displays the fields in the message body object.

e Contents. Displays the contents of the message body in an appropriate format.
Contains a View Full Contents link that opens the message contents in a new
window.

e Trace. Visually traces the path of the message object through the production.
Contains a View Full Trace link that opens the message trace in a new window.

The background color of the Session field indicates the status of the message. Table
7-2 lists the meaning of each color.

Table 7-2: Message list status indicators

Color Indication

Red The message encountered an error.

Green The message marks the start of a session.

Silver The message arrived after a timeout expired and is
marked as Discarded.

Orange The message is suspended.

White and pale tan, in These messages are complete or queued.

alternating rows

7.3.1.1 Message Status

Each message object has a status value that indicates its current status in a normal life
cycle. These status values, which are visible on most pages within the Message
Browser, are Created, Queued, Delivered, Deferred, Completed, Discarded, or
Suspended.
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The message status values apply to instances of request and response messages
individually. Request/response “pairs” are not tracked together for multiple reasons:

e A request might be repeated several times before it is successfully delivered.

e Some requests have an optional response that can be ignored if the message does

not arrive.

e Some responses can be deferred for later delivery.

e Some requests have no response defined for them at all.

Table 7-3: Message status meanings

Message Meaning

Status

Completed The intended recipient has received the message and has finished
processing the message.

Created The message is in transit between sender and target.

Deferred The message response has been deferred by the business operation for later
delivery.

Delivered The intended recipient has received the message.

Discarded The message is a response that reached its destination after the timeout
period for the corresponding request expired.

Queued The message is on a queue.

Suspended The message was suspended by the business operation after failing to reach
its external destination. The message can be resent by clicking Resubmit on
the Suspended Messages page or by clicking Resend on the Message
Viewer page.
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7.3.2 Header Tab

Click the Header tab to display the message header fields for the selected message in
the right pane of the Message Viewer page, as shown in Figure 7-3.
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Figure 7-3: Message header details displayed by clicking the Header tab
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7.3.3

7.3.4

B

ody Tab

Click the Body tab to display the message body fields for the selected message in the

right pane of the Message Viewer page, as shown in Figure 7-4.
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Figure 7-4: Message body details displayed by clicking the Body tab

Contents Tab

Click the Contents tab to display the message contents for the selected message in
the right pane of the Message Viewer page, as shown in Figure 7-5. The Contents

tab is used by advanced users.

by InterSystems

Message Viewer

Header | Bady | Contents | Trace ‘

HL7 ADT_A28 Message - Id = 14, DocType = 'AGMPLRPM:
‘ADT message - Add person information’, 4 Seqments

MSH * ~\& * RPMS-MPI * 8574 ~ 10.24.196.4%

EVN A28 » -2 -2 - 21 ~ ADAM ~ ADAM -~

1
2
3 [PID 172y "Y~_~_~USHS & - & 03¢
4

Figure 7-5: Message contents displayed by clicking the Contents tab
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To display the message contents in a new window, as shown in, click the View Full
Contents link.
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Figure 7-6: Message Contents displayed in a new window

To display a tooltip with a brief description of an item in the Contents pane, move the
pointer over the item and hold it there briefly, as shown in Figure 7-7.
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Figure 7-7: Hovering in the Contents tab to show a tooltip

Each line displayed in the Contents pane is a message segment containing fields,
subcomponents, and end components.
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7.3.5

To display detailed information about a message segment, click the segment to
display the HL7 Schema Segment Structure window, as shown in Figure 7-8.

Version 7.2 Patch 02
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Figure 7-8: Clicking an RPMS-MPI MSH segment structure in the Contents tab displays
additional information

Trace Tab

Click the Trace tab to display the Visual Trace page, which displays a graphic
representation of the Services, Processes, and Operations related to the selected
message, as shown in Figure 7-9.
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Figure 7-9: A message trace is visually represented in the Trace tab
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To display the message trace in a new window, click the View Full Trace link. The
new window contains the Visual Trace page, as shown in Figure 7-10.
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Figure 7-10: Visual Trace page displayed by clicking the View Full Trace link

The display area of the Visual Trace page contains two panes. A visual
representation of each message as it travels from one configuration item to the next is
displayed in the left pane of the Visual Trace page.

To display additional details about a business service, business process, or business
operation in the right pane, click an item in the left pane.
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Figure 7-11: A trace selected in the Visual Trace page

If the graphical representation for a visual trace contains a mail alert, then there may
be a problem in the system.

7.3.6 Messages in Progress

It is not always possible for a message to be immediately delivered. Most host classes
provide some level of recovery from initial obstacles that a message might encounter.
Obstacles to delivery can arise for a number of reasons, including circumstances
outside the Ensemble system, such as an external server going down, or the need to
wait for a decision from another business process or participant, such as workflow
issues. Message status values help track what is happening to a message that is not yet
delivered.

In many cases, business operations are designed to resend a message a given number
of times, at given intervals, before declaring the message failed or announcing a
timeout. Many outbound adapters offer configurable parameters that control the time
interval and number of retries to make in message delivery. Set the values for time
and retries when configuring specific settings for the business operation using the
Management Portal, without changing any classes in Studio.

Some business operations are designed to set the status of any failed messages to
Suspended. Ensemble automatically places all suspended messages on a special
queue. A system administrator can find these messages by going to the Management
Portal home page and then clicking Ensemble, then clicking View, then clicking
Suspended Messages.
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7.3.7

An inspection of the routing information or contents of a specific message might
reveal the reason why the message failed. For example, if the problem is that an
external destination went out of service, a change can be made to reestablish
communication with that server. Then suspended messages can be resent to the
external server by navigating to the Suspended Messages page and clicking
Resubmit. Suspended messages can also be resent by clicking Resend on the
Message Viewer page.

The deferred status does not indicate either delivery or failure. A business operation
can set the status of a response message to be deferred before exiting. The deferred
response can be picked up and sent back to the original requester by any business host
in the production. Between the time when the business operation defers the response,
and when the response is finally sent, the response message has a status of Deferred.
The sender of the original message is unaware of the fact that the message was
deferred. If the original call was synchronous, the call does not return to the sender
until the deferred response is sent.

Resending Messages

Messages can be edited and resent from the Message Viewer page by users with
appropriate security levels.

To resend message, follow these steps:

1. Inthe message list, check the check boxes next to the message(s) to be resent, and
then click Resend to display the Message Resend page, as shown in Figure 7-12.

& Meiage Recend - Windos Inteirsst Fapleees ]
e ®IE S T T == =
x @ Comvert v [ Select

¢ Favortes € Mieage Resend

Resand Massanes Ui Unkmownl e Ligen Vanpent, e, nglir o ENHE
m Edit and Resend b Lt = Resubet st head of queue Resend Messages

The Tolowang 15 a hst of messages thal will be resent when you chek Resend on lhis page:

20121297 120600 RPMSanBound A

%& Local intranet | Protected Mode: Off far RN -
T ¥

Figure 7-12: Resend Messages page
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2. To edit the message before resending it, click Edit then Resend to display the
Message Edit and Resend page.

3. Click Resend to resend the message. A message will display indicating whether
the message was successfully resent or whether there was a problem.
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8.0

8.1

8.2

The Event Log Page

System Events

System events occur naturally throughout the life cycle of a production. System
events are generated and handled internally by Ensemble. Among the ways that
system events are used is putting background processes (jobs) to sleep and waking
them up. System events are also involved in notification of the arrival of messages on
a queue, i.e., an event tells the queue owner that a message has arrived, so that the
owner knows to take the message from the queue.

It is not necessary to have a detailed knowledge of system events to develop an
Ensemble production. System events are handled automatically by the Ensemble
infrastructure. The important thing to remember is that system events are not the same
as alerts, alarms, event log entries, or Ensemble messages.

Ensemble Events

The Ensemble event log does not provide any information about system events. The
event log collects certain types of text message generated by Ensemble host classes.
A developer or system administrator can view event log entries from the Event Log
page. Viewing the event log is a way to “take the pulse” of a production by scanning
the informational text messages that it produces while it runs. Event log entries are
stored persistently in the Ensemble database and may be purged according to age, as
they accumulate.

Some event log entries are generated automatically in all Ensemble productions, such
as the entries that acknowledge production startup or shutdown, which reflect normal
occurrences in the life cycle of the production.

However, most event log entries are generated because the developer of an Ensemble
class decided that certain information would be of interest to a system administrator
in case a problem occurs while the production is running.

To view event log entries, click Ensemble, then click View, then click Event Log on
the Management Portal home page. The Event Log page is shown in Figure 8-1.
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Figure 8-1: Event log messages are color coded
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Events listed in the event log are color-coded using the colors shown in Table 8-1.

Table 8-1: Colors associated with event status in the Event Log

Event Status Row Color

Alert Yellow

Error Pink

Warning Orange

Info Green

User Trace Blue

Ensemble should send an e-mail alert for each event classified as an error (pink). If an
error message is displayed on the Event Log page but does not appear as an Outlook
message in your Inbox, report the problem by copying and pasting the error message
into an e-mail to the OIT Help Desk.

Note: There will be times when messages will display in this
window, but will not generate an e-mail in Outlook.
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9.0

Production Monitor

The Production Monitor page displays real-time status information about the
currently running production in a condensed, one-page format. The Production
Monitor page provides quick access to additional pages for further information. To
display the Production Monitor page in the Management Portal, click Production
Monitor on the Ensemble Monitor menu. The Production Monitor page is shown
in Figure 9-1
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Figure 9-1: Production Monitor page

The system monitor is another way to see what is happening in the system, including
a summary of the Event Log. Viewing the Event Log here can be quicker than
navigating to the Event Log page.

The display area of the Production Monitor page is a grid containing the following
tables:

e Incoming Connections (upper left) Lists all incoming connections from external
systems

e Outgoing Connections (upper right) Lists all outgoing connections to external
systems

e Queues (lower left) Lists the status of Ensemble internal message queues and
how many messages are currently waiting in each queue

e Event Log (lower right) Summarizes recent entries in the event log

By default, the system monitor is automatically updated at frequent intervals. In the
left area, you can clear the Auto update check box to disable these updates.
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Each entry on the system monitor page includes an icon and a color to indicate the
item’s status. The following status indicators appear for connections and queues:

e %] Green dot Indicates a status of Active and OK

e - Yellow dash Indicates a status of currently inactive, but otherwise OK
The following status indicators appear for the event log:

o M Red ! (exclamation mark) Indicates an error

e [W Orange W Indicates a warning

e A Yellow A Indicates an Alert

Click an entry displayed in any of these tables to display details and links to more
information. The links are displayed in the vertical display area at left, under the Auto
update check box.
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10.0 Ensemble E-Mail Alerts

If an e-mail alert is received from Ensemble or an alert is received from within
RPMS, there is a problem that must be resolved. If there is an error within the
Ensemble production, e-mail alerts are sent to individuals listed in the Ensemble e-
mail alert configuration.

Note: Detailed instructions for configuring e-mail alerts and
recipients in Ensemble are found in the Patient Registration
(AG) MPI Interface/Ensemble Installation Guide and
Release Notes.

Figure 10-1 shows an example of an Ensemble e-mail alert for the MPlInbound
adapter.

= Ensemble alert from sy M| Inkound - Windows Internet Explorer

ey | SR el | G Fewsd T | - 5 G B K DG e —

Ensemble alert from sys:MFPlinbound

o Connection made on port 5026 within interval 8

Linilsusen Zorw (Micosd]) A0, =

Figure 10-1: Ensemble e-mail alert for MPlInbound

This alert from MPIlInbound can be ignored it because it does not represent a
significant issue. The MPIInbound alert indicates that the listener is not receiving
messages within five seconds from initially receiving a message.

If the alert shown in Figure 10-2 is received, it means that the MP1 is sending a
message with a segment that is undefined or unknown in Ensemble. Contact the OIT
Help Desk for assistance with this alert.
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/= Ensemble alerl from sys:AGMP L MPIMeszageRouling - Windows Internel Explarer

el | CReiveal | Gfed woe lll- G B K B e =

Ensemble alert from sys: AGMPLMPIMessageRouting

Figure 10-2: Ensemble e-mail alert for AGMPI.MPIMessageRouting

The alert from Ensemble shown in Figure 10-3 can be sent if an RPMS AGMPI
routine had an error.

From: Ensemble_AGMPI@HLOMPI_rpms [Ensemble_AGMPI@HLOMPI_rpms]
Sent: Friday, May 07, 2010 9:20 AM

To:

Subject: Ensemble alert from sys:RPMSInBound

There is an issue obtaining a lock on the HLB global in the
HLOGlobal Inbound Adapter:

Figure 10-3: Ensemble e-mail error alert

Figure 10-4 through Figure 10-23 show e-mail alerts that may be sent from Ensemble.

Note: If any of these e-mail alerts are received, notify the OIT
Help Desk.

"ERROR in Configuration"

Figure 10-4: Configuration Error Message

"There is an issue obtaining a lock on the HLB global in the
HLOGlobal Inbound Adapter:*

Figure 10-5: HLB global Error Message

"There is an issue obtaining a lock on the HLA global in the
HLOGIobal Inbound Adapter:"*

Figure 10-6: HLA global Error Message
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"There was an issue creating a valid HL7 message in the HLOGlobal Inbound
Adapter: "

Figure 10-7: HL7 Error Message

"There was an error in the HLOGloballnbound Adapter:*

Figure 10-8: HLOGIoballnbound Adapter Error Message

"There is an issue obtaining a lock on the HLB global in the
HLOGlIobalOutbound Adapter:™

Figure 10-9: HLB global in the HLOGIlobalOutbound Error Message

"There is an issue obtaining a lock on the HLA global in the
HLOGHIobalOutbound Adapter:™

Figure 10-10: HLA global in the HLOGIlobalOutbound Error Message

“"Failure: The HLOGlobalOutound adapter failed to Process Message (an ACK)
because it did not contain a Message Control ID:*

Figure 10-11: ACK without a Message Control ID Error Message

"Failure: The HLOGlobalOutound adapter failed to Process Message (an ACK)
because the "B" reference node did not exist for Message Control ID"

Figure 10-12: ACK without a B reference node Error Message

"Alert: The HLOGlobalOutound adapter received message (an ACK message) that
did not contain an "AA" or "CA" Acknowledgment Code: The MessageControl ID
is”

Figure 10-13: Missing AA or CA ACK Code Error Message

“"Failure: The HLOGlobalOutound adapter failed to find an open IEN after 100
tries”

Figure 10-14: Failure to find an open IEN Error Message

“"Failure: The HLOGlobalOutound adapter failed while looping though an HL7
message segments: MessagelD=""

Figure 10-15: Failure with MessagelD in HL7 Error Message

“"Failure: The HLOGlobalOutound adapter failed: Error="

Figure 10-16: HLOGIobalOutbound adapter Error Message
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“"Failure: The HLOGlobalOutound adapter failed: Error="

Figure 10-17: HLOGIobal Patient Record Number (also known as DFN or IEN) Error
Message

“MP1 DEN="_DFN_" :z: "_"ERROR WHEN CREATING AO1"

Figure 10-18: Patient Record Number (also known as DFN or IEN) Error Message for AO1

“"MP1 DEN="_DFN_" :z: "_"ERROR WHEN CREATING A03"

Figure 10-19: Patient Record Number (also known as DFN or IEN) Error Message for A03

An e-mail alert containing the message “The HLOGIlobalOutbound adapter failed”
indicates that a programming error occurred within the adapter and must be reported
to OIT. The Ensemble production should be shut down until the error is investigated.

Failure: The HLOGlobalOutound adapter failed: Error= 0

Figure 10-20: HLOGIobalOutbound adapter error

A “TCP Read timeout” error occurs when the MPI sends an unusually large ERR
segment back to the client.

TCP Read timeout (5) expired waiting for terminator SegTerminatorAscii=13,
on |TCP|8899]|2984, data received =""

Figure 10-21: TCP Read timeout error

If a TCP Connect timeout error is occurring repeatedly, the MPI is down and the OIT
Help Desk must be notified immediately.

TCP Connect timeout period (5) expired for 161.223.90.106:8899

Figure 10-22: TCP Connect timeout error

A “No Connection made on port #### within interval 5” alert indicates that the site
might not be receiving acknowledgment messages from the MPI. If a site receives
several of these messages, check Ensemble settings or contact OIT. The alert could be
an indication that there is a problem with the station number, or it could mean that the
network or MPI server is not responding quickly.

No Connection made on port 5026 within interval 5

Figure 10-23: No connection error
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Failure: The HLOGlobalOutound adapter failed to Process Message 308834 (an
ACK) because the "B" reference node did not exist for Message Control ID
14752 345:::

Figure 10-24: Failure to process message error

Note: If any of the above e-mail alerts are received, notify OIT
Help Desk.
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Appendix A: Rules of Behavior

Al

Al1l

The Resource and Patient Management (RPMS) system is a United States
Department of Health and Human Services (HHS), Indian Health Service (IHS)
information system that is FOR OFFICIAL USE ONLY. The RPMS system is
subject to monitoring; therefore, no expectation of privacy shall be assumed.
Individuals found performing unauthorized activities are subject to disciplinary action
including criminal prosecution.

All users (Contractors and IHS Employees) of RPMS will be provided a copy of the
Rules of Behavior (RoB) and must acknowledge that they have received and read
them prior to being granted access to a RPMS system, in accordance IHS policy.

e For alisting of general ROB for all users, see the most recent edition of IHS
General User Security Handbook (SOP 06-11a).

e For a listing of system administrators/managers rules, see the most recent edition
of the IHS Technical and Managerial Handbook (SOP 06-11b).

Both documents are available at this IHS Web site: http://security.ihs.qov/.

The ROB listed in the following sections are specific to RPMS.

All RPMS Users

In addition to these rules, each application may include additional RoBs that may be
defined within the documentation of that application (e.g., Dental, Pharmacy).

Access
RPMS users shall
e Only use data for which you have been granted authorization.

e Only give information to personnel who have access authority and have a need to
know.

e Always verify a caller’s identification and job purpose with your supervisor or the
entity provided as employer before providing any type of information system
access, sensitive information, or nonpublic agency information.

e Be aware that personal use of information resources is authorized on a limited
basis within the provisions Indian Health Manual Part 8, “Information Resources
Management,” Chapter 6, “Limited Personal Use of Information Technology
Resources.”
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RPMS users shall not

Retrieve information for someone who does not have authority to access the
information.

Access, research, or change any user account, file, directory, table, or record not
required to perform their official duties.

Store sensitive files on a PC hard drive, or portable devices or media, if access to
the PC or files cannot be physically or technically limited.

Exceed their authorized access limits in RPMS by changing information or
searching databases beyond the responsibilities of their jobs or by divulging
information to anyone not authorized to know that information.

A.1.2 Information Accessibility

RPMS shall restrict access to information based on the type and identity of the user.
However, regardless of the type of user, access shall be restricted to the minimum
level necessary to perform the job.

RPMS users shall

Access only those documents they created and those other documents to which
they have a valid need-to-know and to which they have specifically granted
access through an RPMS application based on their menus (job roles), keys, and
FileMan access codes. Some users may be afforded additional privileges based on
the functions they perform, such as system administrator or application
administrator.

Acquire a written preauthorization in accordance with IHS polices and procedures
prior to interconnection to or transferring data from RPMS.

A.1.3  Accountability
RPMS users shall

Behave in an ethical, technically proficient, informed, and trustworthy manner.

Log out of the system whenever they leave the vicinity of their personal
computers (PCs).

Be alert to threats and vulnerabilities in the security of the system.

Report all security incidents to their local Information System Security Officer
(ISSO)

Differentiate tasks and functions to ensure that no one person has sole access to or
control over important resources.
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Al4

A.15

e Protect all sensitive data entrusted to them as part of their government
employment.

e Abide by all Department and Agency policies and procedures and guidelines
related to ethics, conduct, behavior, and information technology (IT) information
processes.

Confidentiality
RPMS users shall

e Be aware of the sensitivity of electronic and hard copy information, and protect it
accordingly.

e Store hard copy reports/storage media containing confidential information in a
locked room or cabinet.

e Erase sensitive data on storage media prior to reusing or disposing of the media.
e Protect all RPMS terminals from public viewing at all times.

e Abide by all Health Insurance Portability and Accountability Act (HIPAA)
regulations to ensure patient confidentiality.

RPMS users shall not

e Allow confidential information to remain on the PC screen when someone who is
not authorized to that data is in the vicinity.

e Store sensitive files on a portable device or media without encrypting.

Integrity

RPMS users shall

e Protect their systems against viruses and similar malicious programs.
e Observe all software license agreements.

e Follow industry standard procedures for maintaining and managing RPMS
hardware, operating system software, application software, and/or database
software and database tables.

e Comply with all copyright regulations and license agreements associated with
RPMS software.

RPMS users shall not
¢ Violate federal copyright laws.

e Install or use unauthorized software within the system libraries or folders.
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Use freeware, shareware, or public domain software on/with the system without
their manager’s written permission and without scanning it for viruses first.

A.1.6 System Logon
RPMS users shall

Have a unique User Identification/Account name and password.

Be granted access based on authenticating the account name and password
entered.

Be locked out of an account after five successive failed login attempts within a
specified time period (e.g., one hour).

A.1.7 Passwords
RPMS users shall

Change passwords a minimum of every 90 days.
Create passwords with a minimum of eight characters.

If the system allows, use a combination of alpha-numeric characters for
passwords, with at least one uppercase letter, one lower case letter, and one
number. It is recommended, if possible, that a special character also be used in the
password.

Change vendor-supplied passwords immediately.

Protect passwords by committing them to memory or store them in a safe place
(do not store passwords in login scripts or batch files).

Change passwords immediately if password has been seen, guessed, or otherwise
compromised, and report the compromise or suspected compromise to their ISSO.

Keep user identifications (IDs) and passwords confidential.

RPMS users shall not

Use common words found in any dictionary as a password.

Use obvious readable passwords or passwords that incorporate personal data
elements (e.g., user’s name, date of birth, address, telephone number, or social
security number; names of children or spouses; favorite band, sports team, or
automobile; or other personal attributes).

Share passwords/IDs with anyone or accept the use of another’s password/ID,
even if offered.

Reuse passwords. A new password must contain no more than five characters per
eight characters from the previous password.
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A.1.8

A.19

A.1.10

e Post passwords.

o Keep a password list in an obvious place, such as under keyboards, in desk
drawers, or in any other location where it might be disclosed.

e Give a password out over the phone.

Backups
RPMS users shall

e Plan for contingencies such as physical disasters, loss of processing, and
disclosure of information by preparing alternate work strategies and system
recovery mechanisms.

e Make backups of systems and files on a regular, defined basis.

e If possible, store backups away from the system in a secure environment.

Reporting
RPMS users shall

e Contact and inform their ISSO that they have identified an IT security incident
and begin the reporting process by providing an IT Incident Reporting Form
regarding this incident.

e Report security incidents as detailed in the IHS Incident Handling Guide (SOP
05-03).

RPMS users shall not

e Assume that someone else has already reported an incident. The risk of an
incident going unreported far outweighs the possibility that an incident gets
reported more than once.

Session Timeouts

RPMS system implements system-based timeouts that back users out of a prompt
after no more than 5 minutes of inactivity.

RPMS users shall

e Utilize a screen saver with password protection set to suspend operations at no
greater than 10 minutes of inactivity. This will prevent inappropriate access and
viewing of any material displayed on the screen after some period of inactivity.
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Al11

A.1.12

A.1.13

Hardware
RPMS users shall

e Avoid placing system equipment near obvious environmental hazards (e.g., water
pipes).

e Keep an inventory of all system equipment.

e Keep records of maintenance/repairs performed on system equipment.

RPMS users shall not

e Eat or drink near system equipment.

Awareness
RPMS users shall
e Participate in organization-wide security training as required.

e Read and adhere to security information pertaining to system hardware and
software.

e Take the annual information security awareness.

e Read all applicable RPMS manuals for the applications used in their jobs.

Remote Access

Each subscriber organization establishes its own policies for determining which
employees may work at home or in other remote workplace locations. Any remote
work arrangement should include policies that

e Areinwriting.

e Provide authentication of the remote user through the use of ID and password or
other acceptable technical means.

e Outline the work requirements and the security safeguards and procedures the
employee is expected to follow.

e Ensure adequate storage of files, removal, and nonrecovery of temporary files
created in processing sensitive data, virus protection, and intrusion detection, and
provide physical security for government equipment and sensitive data.

e Establish mechanisms to back up data created and/or stored at alternate work
locations.
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A.2

Remote RPMS users shall

Remotely access RPMS through a virtual private network (VPN) whenever
possible. Use of direct dial in access must be justified and approved in writing and
its use secured in accordance with industry best practices or government
procedures.

Remote RPMS users shall not

Disable any encryption established for network, internet, and Web browser
communications.

RPMS Developers
RPMS developers shall

Always be mindful of protecting the confidentiality, availability, and integrity of
RPMS when writing or revising code.

Always follow the IHS RPMS Programming Standards and Conventions (SAC)
when developing for RPMS.

Only access information or code within the namespaces for which they have been
assigned as part of their duties.

Remember that all RPMS code is the property of the U.S. Government, not the
developer.

Not access live production systems without obtaining appropriate written access,
and shall only retain that access for the shortest period possible to accomplish the
task that requires the access.

Observe separation of duties policies and procedures to the fullest extent possible.

Document or comment all changes to any RPMS software at the time the change
or update is made. Documentation shall include the programmer’s initials, date of
change, and reason for the change.

Use checksums or other integrity mechanism when releasing their certified
applications to assure the integrity of the routines within their RPMS applications.

Follow industry best standards for systems they are assigned to develop or
maintain, and abide by all Department and Agency policies and procedures.

Document and implement security processes whenever available.

RPMS developers shall not

Write any code that adversely impacts RPMS, such as backdoor access, “Easter
eggs,” time bombs, or any other malicious code or make inappropriate comments
within the code, manuals, or help frames.
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Grant any user or system administrator access to RPMS unless proper
documentation is provided.

Release any sensitive agency or patient information.

A.3 Privileged Users

Personnel who have significant access to processes and data in RPMS, such as,
system security administrators, systems administrators, and database administrators,
have added responsibilities to ensure the secure operation of RPMS.

Privileged RPMS users shall

Verify that any user requesting access to any RPMS system has completed the
appropriate access request forms.

Ensure that government personnel and contractor personnel understand and
comply with license requirements. End users, supervisors, and functional
managers are ultimately responsible for this compliance.

Advise the system owner on matters concerning information technology security.

Assist the system owner in developing security plans, risk assessments, and
supporting documentation for the certification and accreditation process.

Ensure that any changes to RPMS that affect contingency and disaster recovery
plans are conveyed to the person responsible for maintaining continuity of
operations plans.

Ensure that adequate physical and administrative safeguards are operational
within their areas of responsibility and that access to information and data is
restricted to authorized personnel on a need-to-know basis.

Verify that users have received appropriate security training before allowing
access to RPMS.

Implement applicable security access procedures and mechanisms, incorporate
appropriate levels of system auditing, and review audit logs.

Document and investigate known or suspected security incidents or violations and
report them to the ISSO, Chief Information Security Officer (CISO), and systems
owner.

Protect the supervisor, superuser, or system administrator passwords.

Avoid instances where the same individual has responsibility for several functions
(i.e., transaction entry and transaction approval).

Watch for unscheduled, unusual, and unauthorized programs.

Help train system users on the appropriate use and security of the system.
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Establish protective controls to ensure the accountability, integrity,
confidentiality, and availability of the system.

Replace passwords when a compromise is suspected. Delete user accounts as
quickly as possible from the time that the user is no longer authorized system.
Passwords forgotten by their owner should be replaced, not reissued.

Terminate user accounts when a user transfers or has been terminated. If the user
has authority to grant authorizations to others, review these other authorizations.
Retrieve any devices used to gain access to the system or equipment. Cancel
logon IDs and passwords, and delete or reassign related active and backup files.

Use a suspend program to prevent an unauthorized user from logging on with the
current user's ID if the system is left on and unattended.

Verify the identity of the user when resetting passwords. This can be done either
in person or having the user answer a question that can be compared to one in the
administrator’s database.

Shall follow industry best standards for systems they are assigned to, and abide by
all Department and Agency policies and procedures.

Privileged RPMS users shall not

Access any files, records, systems, etc., that are not explicitly needed to perform
their duties

Grant any user or system administrator access to RPMS unless proper
documentation is provided.

Release any sensitive agency or patient information.
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Glossary

Archiving
The storing of historical or little-used data off-line (often on tape).

Entry Point

Entry point within a routine that is referenced by a “DO” or “GOTO”
command from a routine internal to a package.

File
A set of related records or entries treated as a single unit.

FileMan
The database management system for RPMS.

Flowsheet

A tabular format for organizing and displaying data in a special section of the
health summary.

Global

In MUMPS, “global” refers to a variable stored on disk (global variable) or
the array to which the global variable may belong (global array).

INDEX (%INDEX)

A Kernel utility used to verify routines and other MUMPS code associated
with a package. Checking is done according to current ANSI MUMPS
standards and RPMS programming standards.

This tool can be invoked through an option or from direct mode
(>D "%INDEX).

Kernel

The set of MUMPS software utilities that function as an intermediary between
the host operating system and application packages, such as Laboratory and
Pharmacy. The Kernel provides a standard and consistent user and
programmer interface between application packages and the underlying
MUMPS implementation. These utilities provide the foundation for RPMS.

Ensemble 2012
Management Portal Manual Glossary
September 2013

65



Patient Registration MPI Interface (AG) Version 7.2 Patch 02

Menu

A list of choices for computing activity. A menu is a type of option designed
to identify a series of items (other options) for presentation to the user for
selection. When menu-type options are displayed, the prompt includes the
name of the menu preceded by the word “Select” and followed by the word
“option,” as in “Select Menu Management option” (the menu’s “Select”
prompt).

Namespace

A uniqgue set of two to four alpha characters assigned by the database
administrator to a software application.

Option
An entry in the Option file. As an item on a menu, an option provides an
opportunity for users to select it, thereby invoking the associated computing
activity. Options may also be scheduled to run in the background, non-
interactively, by TaskMan.

Panel

A tabular format for presenting a series of clinical measurements or results in
the health summary.

Queuing

Requesting that a job be processed at a later time rather than within the current
session.

Routine

A program or sequence of instructions called by a program that may have
some general or frequent use. MUMPS routines are groups of program lines
that are saved, loaded, and called as a single unit via a specific name.

Utility
A callable routine line tag or function. A universal routine usable by anyone.
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Acronym List

AG Namespace for Patient Registration

ICD International Classification of Diseases.
IHS Indian Health Service

IEN Internal Entry Number. The number used to

identify an entry within a file. Every record has a
unique internal entry number.

IRM Information Resource Management. The IHS
personnel responsible for information systems
management and security.

MPI Master Patient Index

RPMS Resource and Patient Management System. A
series of integrated software components that
includes clinical, administrative, and financial
functions.

SQL Structured Query Language
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Contact Information

If you have any questions or comments regarding this distribution, please contact the OIT Help
Desk.
Phone: (505) 248-4371 or (888) 830-7280 (toll free)

Fax: (505) 248-4363
Web:  http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm

Email: support@ihs.gov
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Trademark Notice

Ensemble is a registered trademark of InterSystems Corporation.
HLY7 is a registered trademark of Health Level Seven, Inc.

Windows is a registered trademark of Microsoft Corporation.
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